
ii 
 

  Oracle® Fusion Middleware 

Using ServiceNow Adapter 

Release 12c (12.2.1.3.0) 

E88146-01 

June 2017 
  



Oracle Fusion Middleware Using ServiceNow Adapter, Release 12c (12.2.1.3.0) 
 
E88146-01 
 
Copyright © 2017 Oracle and/or its affiliates. All rights reserved. 
 
Primary Author: Ashish Joy  
 
Contributors:  Raman Dhawan, Susheel Patwal, Subodh Gaur, Himanshu Grover and Shalindra Singh. 
 
 
This software and related documentation are provided under a license agreement containing restrictions on use and 
disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or 
allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, 
perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of 
this software, unless required by law for interoperability, is prohibited. 
 
The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any 
errors, please report them to us in writing. 
 
If this software or related documentation is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. 
Government, the following notice is applicable: 
 
U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to 
U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable 
Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure, 
modification, and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government 
contract, and, to the extent applicable by the terms of the Government contract, the additional rights set forth in FAR 
52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500 Oracle Parkway, Redwood 
City, CA 94065. 
 
This software is developed for general use in a variety of information management applications. It is not developed or 
intended for use in any inherently dangerous applications, including applications which may create a risk of personal injury. 
If you use this software in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, 
redundancy, and other measures to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any 
liability for any damages caused by use of this software in dangerous applications. 
 
Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks of their 
respective owners. 
 
This software and documentation may provide access to or information on content, products, and services from third parties. 
Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to 
third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or 
damages incurred due to your access to or use of third-party content, products, or services. 
 

  



iv 
 

Contents 

Contents ......................................................................................................................................... iv 

Preface ........................................................................................................................................... vi 

1  Introduction to ServiceNow Adapter ........................................................................................ 1-1 

About ServiceNow Adapter...................................................................................................... 1-1 

Installing the Cloud Adapters ................................................................................................... 1-1 

Performing Postinstallation Configuration Tasks ..................................................................... 1-1 

Obtaining the Authentication Credentials ............................................................................... 1-1 

Unsupported Features ............................................................................................................. 1-2 

Restrictions .............................................................................................................................. 1-2 

2 Prerequisites .............................................................................................................................. 2-1 

Enable Webservices for the specified tables ........................................................................... 2-1 

Ensure Integration User has Appropriate Role ........................................................................ 2-3 

3  Understanding the ServiceNow Adapter Features ................................................................... 3-5 

Understanding ServiceNow Cloud Adapter Design Integration Patterns ................................ 3-5 

Designing an Integration with the Adapter Configuration Wizard .......................................... 3-6 

Monitoring Your Application During Runtime ....................................................................... 3-10 

Artifacts Creation ................................................................................................................... 3-10 

4  Designing SOA Composite Applications .................................................................................... 4-1 

Creating a SOA Composite Application .................................................................................... 4-1 

Adding an Adapter to a SOA Composite Application as a Reference ...................................... 4-2 

Completing Design of a SOA Composite Application ............................................................... 4-3 

5  Designing Oracle Service Bus Business Services ....................................................................... 5-4 

Creating an Oracle Service Bus Business Service ..................................................................... 5-4 

Adding an Adapter to a Business Service as a Reference ........................................................ 5-5 

Completing Design of an Oracle Service Bus Business Service ................................................ 5-6 

6  Configuring ServiceNow Adapter Properties ............................................................................ 6-7 

Configuring Basic Information Properties ................................................................................ 6-7 

What You Can Do from the Basic Info Page ......................................................................... 6-7 

What You See on the Basic Info Page .................................................................................. 6-8 

Configuring Oracle Cloud Adapter Connection and CSF Key Properties.................................. 6-8 



What You Can Do from the Oracle Cloud Adapter Connection Page .................................. 6-8 

What You See on the Oracle Cloud Adapter Connection Page ............................................ 6-9 

What You Can Do from the Oracle Cloud Adapter CSF Key Page ........................................ 6-9 

What You See on the Oracle Cloud Adapter CSF Key Page .................................................. 6-9 

Configuring ServiceNow Adapter Trigger Applications Properties ........................................ 6-10 

What You Can Do from the ServiceNow Adapter Applications Page ................................ 6-10 

What You See on the ServiceNow Adapter Applications Page .......................................... 6-10 

Configuring ServiceNow Adapter Trigger Fields Properties ................................................... 6-10 

What You Can Do from the ServiceNow Adapter Fields Page ........................................... 6-11 

What You See on the ServiceNow Adapter Fields Page .................................................... 6-11 

Configuring ServiceNow Adapter Trigger Conditions Properties ........................................... 6-11 

What You Can Do from the ServiceNow Adapter Conditions Page ................................... 6-11 

What You See on the ServiceNow Adapter Conditions Page ............................................ 6-11 

Configuring ServiceNow Target Operation Properties .......................................................... 6-12 

What You Can Do from the ServiceNow Cloud Target Operation Page ............................ 6-12 

What You See on the ServiceNow Cloud Target Operation Page ...................................... 6-12 

Configuring ServiceNow Adapter Extended Query Parameters ............................................ 6-13 

What You Can Do from the ServiceNow Adapter Extended Query Parameters Page....... 6-13 

What You See on the ServiceNow Adapter Extended Query Parameters Page ................ 6-14 

Reviewing Configuration Values on the Summary Page ........................................................ 6-15 

What You Can Do from the Summary Page ....................................................................... 6-15 

What You See on the Summary Page ................................................................................ 6-15 

7  Managing Applications ........................................................................................................... 7-16 

Post Deployment Steps of Inbound Adapter ......................................................................... 7-16 

Managing the Application in Oracle Enterprise Manager Fusion Middleware Control......... 7-16 

Testing Oracle Service Bus Business Services from Oracle Service Bus Console ................... 7-17 

 

  



vi 
 

Preface 

Using ServiceNow Adapter describes, how to use the ServiceNow adapter in your SOA composite 

applications and Oracle Service Bus business services. 

This section consists of the following topics: 

 Audience 

 Related Resources 

 Conventions 

Audience 

Using the ServiceNow Adapter is intended for users who want to create, deploy, test, and monitor 

applications that use the ServiceNow adapter. 

Related Resources 

For more information, see these Oracle Resources: 

 Developing SOA Applications with Oracle SOA Suite 

 Administering Oracle SOA Suite and Oracle Business Process Management Suite 

 Administering Oracle Service Bus 

 Understanding Technology Adapters 

Conventions 

The following text conventions are used in this document: 

 

 

Convention Meaning 

boldface 

 

 

italic 
 

 
monospace 

 
Boldface type indicates graphical user interface elements 

associated with an action, or terms defined in text or the glossary. 

 

Italic type indicates book titles, emphasis, or placeholder 

variables for which you supply particular values. 

 

Monospace type indicates commands within a paragraph, URLs, 

code in examples, text that appears on the screen, or text that you 

enter. 



 
Introduction to ServiceNow Adapter 1-1 

 

1  

Introduction to ServiceNow Adapter 

This section introduces the ServiceNow Adapter. 

This chapter consists of the following sections: 

 About the ServiceNow Adapter 

 Installing the Cloud Adapters 

 Performing Postinstallation Configuration Tasks 

 Obtaining the Authentication Credentials 

 Unsupported Features 

About ServiceNow Adapter 

The ServiceNow Adapter integrates On-Premise and SaaS application with Geneva and Helsinki 

release of ServiceNow. 

ServiceNow provides platform-as-a-service (PaaS) enterprise service management software for 

human resources, law, facilities management, finance, marketing, and field operations. 

ServiceNow specializes in IT service management (ITSM) applications and automates common 

business processes. ServiceNow contains a number of modular applications that can vary by 

instance and user. 

Installing the Cloud Adapters 

See the README.txt available with the patch for instructions on installing the cloud adapters. 

After you complete adapter installation, perform the tasks described in Performing 

Postinstallation Configuration Tasks. 

Note: For information about supported versions and platforms, see the release certification 

matrix at Supported System Configurations. 

Performing Postinstallation Configuration Tasks  

You must perform postinstallation configuration tasks after installing the cloud adapters.  

For information about postinstallation configuration tasks, see the Oracle Cloud Adapters 

Postinstallation Configuration Guide.  

Obtaining the Authentication Credentials 

Obtain the user name and password that are required for creating the Credential Store 

Framework (CSF) authentication key in Oracle JDeveloper and Oracle Enterprise Manager 

Fusion Middleware Control from your SOA domain administrator. These credentials are 
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required for most cloud adapters. For the Oracle ServiceNow Cloud adapter, the credentials 

require three properties (CSF Key name, username, and password). 

Unsupported Features 

The adapter does not support the following features: 

 Adapter runtime retry configuration properties such as jca.retry.count, jca.retry.backoff, 

jca.retry.interval, and jca.retry.maxInterval. 

 Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion Middleware 

Control. 

 The display of properties in the Properties tab for a reference (outbound) adapter in Oracle 

Enterprise Manager Fusion Middleware Control (for example, service WSDL URL, CSF key 

used, and others). These are the reference adapters that you select on the Services and 

References page. 

 Rejected message handling 

 The following message encryption and decryption features available when you right-click a 

cloud adapter in the Exposed Service swimlane or External References swimlane in Oracle 

JDeveloper: 

o Protect Sensitive Data > Encrypt Request Data for cloud adapters in the 

Exposed Service swimlane. 

o Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the 

External References swimlane. 

 The policy attachments feature available when you right-click a cloud adapter in the Exposed 

Service swimlane or External References swimlane in Oracle JDeveloper. 

Restrictions 

Note the following restrictions: 

Not all Oracle Fusion Application services are available in SaaS mode because the Oracle 

Fusion Application topology splits visibility to web and service resources into two categories: 

internal and external. Therefore, some services are internal and cannot be used by the adapter for 

integration. Only external services are available for public consumption. 

The adapter cannot be used for integrating the interfamily modules, because services defined on 

them are not external services. 
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Prerequisites 

The following pre-requisites must be performed or checked on ServiceNow instance before 

utilizing Oracle Cloud Adapter for ServiceNow.com to connect to that particular ServiceNow 

instance. 

Enable Webservices for the specified tables 

A user must check the following ServiceNow tables and ensure that webservices have been enabled 

for them: 

Tables Operations 

sys_plugins 
To get standard apps 

sys_app 
To get custom apps 

sys_db_object 
To get modules 

sys_ui_section 
To get View fields in Get operation 

sys_ui_element 
To get View fields in Get operation 

sys_soap_message 
For Insert/Delete of ServiceNow Outbound 

SOAP message 

sys_soap_message_function 
For Insert ServiceNow Outbound SOAP message 

Function 

sys_script 
For Insert/Update/Delete of ServiceNow 

Business Rule 

A user must follow these steps to get enable webservices for the tables in the ServiceNow ServiceNow 

instance: 

1. Login to ServiceNow cloud application (<xxx>.service-now.com) with administrator 

credentials. 

2. On the home page, type tables in the quick search box on the left pane and click the Tables 

hyperlink from the search results. The right pane displays the list of tables. 
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3. Search for each of the ServiceNow tables (from the table-above) using Search box or locate a 

table using the show and hide filter as shown in the following image. 

The following screenshot displays the search results of the sys_plugins ServiceNow table 

 

4. Click and open the table. 

5. Locate and select the check box Allow access to this table via web services if it is not 

selected already. 
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6. Save the settings. 

 

Perform the above steps for all ServiceNow tables listed above. 

Ensure Integration User has Appropriate Role 

ServiceNow user with default Soap SOAP role (without any customization or changes) is required to 

configure or use the Oracle cloud adapter for ServiceNow.com. 

The default soap SOAP role has below the following permissions: - 

Can query, create, update, and delete records on all tables, as well as execute scripts. This is verified by us 

but ServiceNow.com recommends to use using the admin role. 

Note: In case a SOAP role has been modified or due to some reasons the SOAP role is not 

functional, then the user must follow ServiceNow.com recommendations and use the admin 

role. 
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In case, the user does not want to assign the admin role then the user can create a custom role, add accesses 

to the following tables, and assign the default SOAP role to the custom role. 

 sys_plugins 

 sys_app 

 sys_db_object 

 sys_ui_section 

 sys_ui_element 

 sys_soap_message 

 sys_soap_message_function 

 sys_script 
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Understanding the ServiceNow Adapter 

Features 

The Oracle ServiceNow Cloud adapter provides the following features. 

This chapter consists of the following topics: 

 Understanding ServiceNow Cloud Adapter Design Integration Patterns 

 Designing an Integration with the Adapter Configuration Wizard 

 Monitoring Your Application During Runtime 

 Artifacts Creation 

Understanding ServiceNow Cloud Adapter Design 

Integration Patterns 

Oracle ServiceNow Cloud adapter supports the following design integration patterns in the 

Adapter Configuration Wizard. 

Outbound Integration from ServiceNow Cloud Adapter into the ServiceNow Cloud 
Application 

 You configure the ServiceNow Cloud adapter to connect to the ServiceNow Cloud 

application. 

 You navigate through the set of available business objects (standard and custom) and select an 

operation to invoke the object. You can also use the search facility to locate a business object. 

 You save the adapter configuration and exit the Adapter Configuration Wizard.  

 You map the application business object with the logical business object of ServiceNow 

Cloud. 

 You complete the design of the SOA composite application. 

At runtime, the SOA composite application performs the selected operation on the business 

object on ServiceNow Cloud using the ServiceNow Cloud adapter. 

Inbound Integration into ServiceNow Cloud Adapter from the ServiceNow Cloud 
Application 

The ServiceNow Cloud adapter can also be configured for inbound connectivity. For example, 

you may want to integrate an on-premise application with the ServiceNow Cloud application by 

defining an inbound service interface using the ServiceNow Cloud adapter. This service is then 

invoked by ServiceNow Cloud. 

 You define an inbound service interface to be invoked by ServiceNow Cloud. 
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 You configure a service endpoint by browsing through a list of objects. You select the 

business object to receive from ServiceNow Cloud as a request payload to this SOA 

composite application. 

 You select the fields to be included in the payload from ServiceNow Cloud. 

 You select the event type, on which ServiceNow Cloud will be notifying the ServiceNow 

adapter. Optionally you can also specify the conditions on which ServiceNow adapter will be 

receiving the notifications 

 You complete the ServiceNow Cloud adapter configuration. 

 You complete the design of the SOA composite application as per the business requirements. 

Designing an Integration with the Adapter Configuration 

Wizard 

You use the Adapter Configuration Wizard to include the ServiceNow Cloud adapter in a SOA 

composite application or an Oracle Service Bus business service. 

The Adapter Configuration Wizard consists of configuration pages that enable you to select the 

artifacts required to communicate with the ServiceNow Cloud application. You can configure 

the adapter in the inbound (source) direction or the outbound (target) direction. 

 Inbound (source) direction: 

The Basic Info page prompts you to enter a meaningful name and optional description. 

 

The Connection page prompts you to specify the ServiceNow instance name, security policy 

(BASIC AUTH), and CSF authentication key to use. The authentication key is created by 

clicking the Add icon to specify the key name, user name, and password. You must also specify 

these same CSF authentication key values in Oracle Enterprise Manager Fusion Middleware 

Control. For information, see the Oracle Cloud Adapters Postinstallation Configuration Guide. 

You can also test the connection to the ServiceNow Cloud application on the Connection page. 

This enables you to confirm that the URL to the service catalog service and credentials are 

correct. Status is displayed that indicates whether the connection is successful and whether the 
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credentials are authenticated by the ServiceNow Cloud application. Any errors that occurred 

during the attempt to connect are also displayed. 

 

The Applications page prompts you to select the application and a module within that 

application. 
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The Fields page prompts you to select fields that you want to receive in the notification. 

 

The Conditions page prompts you to select the event type and enter the fields conditions on 

which the even should be received. 
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The Summary page (Inbound) displays your selections from the previous pages. 

 

 Outbound (source) direction: 

The Basic Info page prompts you to enter a meaningful name and optional description. This is 

the same page that is displayed in the inbound direction.  

The Connection page prompts you to specify the ServiceNow instance name, security policy 

(basic authentication), and CSF authentication key to use. This is the same page that is displayed 

in the inbound direction.  

The Operations page prompts you to select a business object or service and the operation to 

perform on your selection. A search facility based on service names is also provided. To quickly 

select a business service, you type a search string. The list renders only matching business 

services in the list browser instead of showing all services. 
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The Summary (Outbound) page displays your selections from the previous pages. 

 

Monitoring Your Application During Runtime 

This section describes the runtime aspects of using the ServiceNow adapter.  

You use the runtime part of the adapter for delivering the information generated during design 

time to the service endpoint. You can monitor your SOA composite application or Oracle 

Service Bus business service from Oracle Enterprise Manager Fusion Middleware Control. You 

can also test your Oracle Service Bus business service from Oracle Service Bus Console.  

Artifacts Creation 

The following artifacts are created for each adapter instance in the Application window in Oracle 

JDeveloper: 

 WSDL file: Only the standard WSDL file type is supported. 

 JCA file: Contains the internal implementation details used by the adapter during runtime. It 

contains the different interaction and connection properties used by the adapter. 

When application configuration is complete, you can deploy the application from Oracle 

JDeveloper to the runtime environment. 

For information about the details to specify in the fields of the wizard pages, see Configuring 

Oracle ServiceNow Adapter Properties. 
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Designing SOA Composite Applications 

This section describes how to design a SOA composite application with the ServiceNow cloud 

adapter. 

This section consists of the following topics: 

 Creating a SOA Composite Application 

 Adding an Adapter to a SOA Composite Application as a Reference 

 Completing Design of a SOA Composite Application 

Creating a SOA Composite Application 

This section provides an overview of how to create a SOA composite application in which to 

include the adapter as an exposed service or external reference. 

1. Start Oracle JDeveloper. 

2. From the File menu, select New > Application. 

3. In the New Gallery dialog, select SOA Application from the Items list, then click OK. The 

SOA Create SOA Application wizard is displayed. 

4. Specify an application name, and click Next. 

5. Specify a project name, and click Next. 

6. Select Composite with BPEL Process, and click Finish.  

The SOA composite application is displayed for designing in the SOA Composite Editor. 
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Adding an Adapter to a SOA Composite Application as a 

Reference 

You can add an Oracle ServiceNow Cloud adapter to a SOA composite application as an 

outbound (target) reference to the External References swimlane in Oracle JDeveloper. 

1. Go to the Component Palette in your SOA composite application. 

2. Go to the Cloud section under Custom/Third Party. 

The adapters are displayed. 

 

3. Drag the adapter to the appropriate swimlane: 

a) To create an inbound (source) service, drag the adapter to the Exposed Services swimlane, 

and see the following sections that describe the wizard pages for configuring the adapter: 

• Configuring Basic Information Properties 

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties 

• Configuring ServiceNow Applications Properties 

• Configuring ServiceNow Fields Properties 

• Configuring ServiceNow Conditions Properties 

• Reviewing Configuration Values on the Summary Page 

b) To create an outbound (target) reference, drag the adapter to the External References 

swimlane, and see the following sections that describe the wizard pages for configuring the 

adapter. 

• Configuring Basic Information Properties 

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties 
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• Configuring ServiceNow Cloud Target Operation Properties 

• Reviewing Configuration Values on the Summary Page 

Completing Design of a SOA Composite Application 

This section provides an overview of how to complete design of your SOA composite 

application and deploy the application. 

1. Design the remaining contents of your SOA composite application. For example: 

c) Connect the BPEL process to the adapter. For this example, the BPEL process is connected 

to the adapter as an external reference: 

d) Design the contents of the BPEL process. For example: 

a. Double-click the BPEL process. 

b. Add and configure an invoke activity to invoke the adapter 

c. Add and configure assign activities to copy the contents of one variable to another 

when sending and receiving messages to and from the adapter. 

d. Add and configure other activities, as appropriate. 

e. When complete, view the SOA composite application in the SOA Composite 

Editor. 

For specific information about creating and designing SOA composite applications, see 

Developing SOA Applications with Oracle SOA Suite. 

2. Deploy the SOA composite application: 

a) In the navigator, right-click the project and select Deploy > project_name. 

b) Follow the steps in the deployment wizard to deploy the SOA composite application to the 

application server. 
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Designing Oracle Service Bus Business 

Services 

This section describes how to design an Oracle Service Bus business service with the adapter in 

Oracle JDeveloper. 

 Creating an Oracle Service Bus Business Service 

 Adding an Adapter to a Business Service as a Reference 

 Completing Design of an Oracle Service Bus Business Service 

Creating an Oracle Service Bus Business Service 

This section provides an overview of how to create an Oracle Service Bus business service in 

which to include the adapter in Oracle JDeveloper. 

1. Start Oracle JDeveloper. 

2. From the File menu, select New > Application. 

3. In the New Gallery dialog, select Service Bus Application from the Items list, then click OK. 

4. Specify an application name, and click Next. 

5. Specify a project name. 

6. Select Service Bus, and click Finish. 

The Oracle Service Bus business service is displayed for designing in the Oracle Service Bus 

Overview Editor. 
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Adding an Adapter to a Business Service as a Reference 

You can add the adapter to an Oracle Service Bus business service as an inbound (source) proxy 

service to the Proxy Services swimlane or as an outbound (target) external service to the 

External Services swimlane in Oracle JDeveloper. 

1. Go to the Component Palette in your Oracle Service Bus business service. 

2. Go to the Cloud section under Custom/Third Party. 

 

3. Drag the adapter to the appropriate swimlane: 

c) To create an inbound (source) service, drag the adapter to the Exposed Services swimlane, 

and see the following sections that describe the wizard pages for configuring the adapter: 

• Configuring Basic Information Properties 

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties 

• Configuring ServiceNow Adapter Trigger Applications Properties 

• Configuring ServiceNow Adapter Trigger Fields Properties 

• Configuring ServiceNow Adapter Trigger Conditions Properties 

• Reviewing Configuration Values on the Summary Page 

d) To create an outbound (target) reference, drag the adapter to the External References 

swimlane, and see the following sections that describe the wizard pages for configuring the 

adapter. 

• Configuring Basic Information Properties 

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties 

• Configuring ServiceNow Cloud Target Operation Properties 

• Reviewing Configuration Values on the Summary Page 
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Completing Design of an Oracle Service Bus Business 

Service 

This section provides an overview of how to complete design of your Oracle Service Bus business 

service and deploy the application. 

1. Design the contents of your Oracle Service Bus business service. For example, to configure an 

Oracle Service Bus proxy service in your business service: 

a)  In the Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins lane and 

select Insert > Pipeline. 

The Create Pipeline Service dialog is displayed. 

b) Enter a name for the pipeline and select the project location, then click Next 

c) Select WSDL as the Service Type. 

d) To the right of the WSDL selection, click the Browse icon to select the WSDL. 

e) Select Application. 

f) Expand Resource Chooser and select the WSDL file, then click OK. 

g) Ensure that Expose as a Proxy Service is selected. 

h) From the Proxy Transport list, select http, then click Finish.  

The Pipeline component is displayed in the Oracle Service Bus Overview Editor. 

i) Connect the external service to the Pipeline component. 

For more information about creating and designing an Oracle Service Bus business service, 

see Developing Services with Oracle Service Bus. 

2. Open the pipeline that shows the default routing. 

3. Verify the service and corresponding operation are displayed in the Routing Properties tab at the 

bottom of the dialog. 

The outbound project is ready for deployment. 

4. Deploy the business service. 

a) Select the project, then select Deploy to Service Bus Server. 

b) Follow the steps in the deployment wizard. 
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Configuring ServiceNow Adapter 

Properties 

The Service Adapter enables you to create integrations with a ServiceNow cloud application. 

This chapter consists of the following topics: 

 Configuring Basic Information Properties 

 Configuring Oracle Cloud Adapter Connection and CSF Key Properties 

 Configuring ServiceNow Adapter Trigger Applications Properties 

 Configuring ServiceNow Adapter Trigger Fields Properties 

 Configuring ServiceNow Adapter Trigger Conditions Properties 

 Configuring ServiceNow Cloud Target Operation Properties 

 Configuring ServiceNow Adapter Invoke Extended Query Parameters 

 Reviewing Configuration Values on the Summary Page 

Configuring Basic Information Properties 

You can enter a name and description on the Basic Info page of each source and target adapter in 

your integration. 

This section consists of the following topics: 

 What You Can Do from the Basic Info Page 

 What You See on the Basic Info Page 

What You Can Do from the Basic Info Page 

You can specify the following values on the Basic Info page. The Basic Info page is the initial 

wizard page that is displayed whenever you drag an adapter to the trigger (source) or invoke 

(target) area supported by your adapter. 

 Specify a meaningful name. 

 Specify a description of the responsibilities. 
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What You See on the Basic Info Page 

The following table describes the key information on the Basic Info page. 

Element Description 

What do you want to call your endpoint? Provide a meaningful name so that others can 

understand the responsibilities of this 

connection. You can include English 

alphabetic characters, numbers, underscores, 

and dashes in the name. You cannot include 

the following: 

 Blank spaces (for example, My Inbound 

Connection) 

 Special characters (for example, #;83& or 

righ(t)now4) 

 Multibyte characters 

What does this endpoint do? Enter an optional description of the 

connection’s responsibilities. For example: 
This connection receives an 

inbound request to synchronize 

account information with the 

cloud application. 

Configuring Oracle Cloud Adapter Connection and CSF 

Key Properties 

Enter the Oracle Cloud adapter configuration connectivity and Credential Store Framework 

(CSF) key values for your integration. 

This section consists of the following topics: 

 What You Can Do from the Oracle Cloud Adapter Connection Page 

 What You See on the Oracle Cloud Adapter Connection Page 

 What You Can Do from the Oracle Cloud Adapter CSF Key Page 

 What You See on the Oracle Cloud Adapter CSF Key Page 

What You Can Do from the Oracle Cloud Adapter Connection Page 

You can specify the following connection values for the Oracle Cloud adapter. 

 Specify the WSDL URL for some adapters. If you are configuring the ServiceNow adapter, no 

WSDL is required but you need to provide the ServiceNow’s instance URL. 

 Specify the security policy. 

 Create the authentication key. A key created for one direction (for example, outbound) is also 

available for selection in the other direction (for example, inbound). 
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What You See on the Oracle Cloud Adapter Connection Page 

The following table describes the key information on the Oracle Cloud Adapter Connection 

page. 

Element Description 

ServiceNow instance name 
Specify the ServiceNow instance name i.e. 
ServiceNow url, for example 
https://host_name.service-

now.com/ 

Security Policy 
Select the security policy appropriate to your 
environment (for example, 
USERNAME_PASSWORD_TOKEN). 
• The wizard shows all policies, including 
those that may not be applicable. To make 
a correct selection, you must have a 
knowledge of policies. For example, you 
cannot select a SAML-based policy 
because the identity is not propagated. 
• The policies you apply to the cloud 
adapter are unique to the cloud adapter 
and do not impact other endpoints in the 
composite. 

Authentication Key 
Select the CSF authentication key. 
• Add: Click to create a new authentication 
key. You must specify the key name, user 
name, and password. To successfully 
deploy and administer your application, 
you must specify these same values in 
Oracle Enterprise Manager Fusion 
Middleware Control. 
• Edit: Click to edit an authentication key. 
• Delete: Click to delete an authentication key. 

Test 
Click to validate the authentication key. 

What You Can Do from the Oracle Cloud Adapter CSF Key Page 

You can specify the following CSF key values for the Oracle Cloud adapter. 

 CSF key name 

 User name, password and re-enter password.  

What You See on the Oracle Cloud Adapter CSF Key Page 

The following table describes the key information on the Oracle Cloud adapter CSF Key page. 

Element Description 

CSF Key Name 
Specify the CSF key to enable runtime 
injection of credentials. The adapter uses the 
CSF to retrieve the username and password 
required for authentication with the 
application (for example, the ServiceNow 
Cloud or Oracle HCM application). This key 
identifies your login credentials during 
design-time. To successfully deploy and 
administer your application, you must 
specify these same values in Oracle 
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Enterprise Manager Fusion Middleware 
Control. For instructions, see the Oracle Cloud 
Adapters Postinstallation Configuration Guide. 

User Name 
Enter the user name for connecting to your 
application (ServiceNow 
Cloud User Name). Your 
administrator provides you with user 
credentials. 

Password 
Enter the password for connecting to your 
application. (ServiceNow 
Cloud Password) 

Re-enter Password 
Re-enter the same password a second time 
(ServiceNow 
Cloud Password). 

Configuring ServiceNow Adapter Trigger Applications 

Properties 

Select the application and module for which you want to received notifications  

This section consists of the following topics: 

 What You Can Do from the ServiceNow Adapter Applications Page 

 What You See on the ServiceNow Adapter Applications Page 

What You Can Do from the ServiceNow Adapter Applications Page 

Use the configuration page to select an application and module for which you want receive 

notifications. 

What You See on the ServiceNow Adapter Applications Page 

The following table describes the key information on the ServiceNow Adapter Applications 

page. 

Element Description 

Select Application 
Use the scrolling list to select an application for 
which you want to receive notifications when it is 
inserted, updated, or deleted. 

Select Module 
Use the scrolling list to select a module from the 
application you previously selected. 

Filter by Application Name 
Type the initial letters to filter the display of 
applications. 

Filter by Module Name 
Type the initial letters to filter the display of 
modules. 

Configuring ServiceNow Adapter Trigger Fields Properties 

Enter the ServiceNow Adapter trigger format definition parameters. 

This section consists of the following topics: 

 What You Can Do from the ServiceNow Adapter Fields Page 

 What You See on the ServiceNow Adapter Fields Page 
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What You Can Do from the ServiceNow Adapter Fields Page 

Use the Fields page to specify the fields for which you want notification when they are inserted, 

updated, or deleted. 

What You See on the ServiceNow Adapter Fields Page 

The following table describes the key information on the ServiceNow Adapter Fields page. 

Element Description 

Type field name to filter Type the initial letters of the field name to 

filter the display of names in the list. Use the 

dropdown menu to narrow or widen 
the list of fields: 

 ALL — Shows all of the available fields 

 CUSTOM — Shows only the custom fields 

 STANDARD — Shows only the standard 

fields 

Available Fields Use the scrolling list to select a list of fields for 

which you want to receive notifications when it 

is inserted, updated, or deleted. These are fields 

contained in the application and module you 

selected on the Configurations page. The fields 

are moved to the Selected Fields list as you 

select them. 

You can double-click on a field name or use 

the arrow buttons to move the field to the 

Selected Fields list. 

Selected Fields The list of fields you have selected. 

Configuring ServiceNow Adapter Trigger Conditions 

Properties 

Use this page to select actions that trigger a notification when they are performed on the selected 

fields. You can also set condition statements that govern the conditions under which the 

notifications are triggered. 

This section consists of the following topics: 

 What You Can Do from the ServiceNow Adapter Conditions Page 

 What You See on the ServiceNow Adapter Conditions Page 

What You Can Do from the ServiceNow Adapter Conditions Page 

You can use the ServiceNow Adapter Conditions page to create complex condition statements to 

notify you when the selected fields are inserted, updated or deleted. 

What You See on the ServiceNow Adapter Conditions Page 

The following table describes the key information on the ServiceNow Adapter Conditions page. 
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Element Description 

Receive notifications when asset gets: 

 Inserted 

 Updated 

 Deleted 

Select one of the listed events (inserted, 

updated, deleted) that will trigger a notification 

when it is performed on the selected 

application, module or field. 

Field conditions Use this part of the page to construct 

statements that govern the conditions under 

which the notifications are triggered. Click the 

checkbox to activate the condition control. 

Configuring ServiceNow Target Operation Properties 

Enter the ServiceNow Cloud target operation values for your integration. 

This section consists of the following topics: 

 What You Can Do from the ServiceNow Cloud Adapter Target Operation Page 

 What You See on the ServiceNow Cloud Adapter Target Operation Page 

What You Can Do from the ServiceNow Cloud Target Operation 

Page 

You can select an application and module on which to perform an operation. Then select the 

operation to perform in the application. 

What You See on the ServiceNow Cloud Target Operation Page 

The following table describes the key information on the ServiceNow Adapter Operations page. 

Element Description 

Select Application Select the ServiceNow application. 

Select Module Select the ServiceNow module on which you 

want to perform the operation 

Filter by Application Name Type the initial letters to filter the display of 

applications 

Filter by Module Name Type the initial letters to filter the display of 

module 

Select an Operation Select one of the following operations to 

perform in the ServiceNow application from 

the dropdown menu: 

• Aggregate — Query a table using an 

aggregate function like SUM, COUNT, MIN, 

MAX, AVG 

• Delete — Delete one or more record from the 

selected table. 

• Get — Query the selected table by example 

values and return the matching records and 



 
Configuring ServiceNow Adapter Properties 6-13 

 

their fields. 

• Insert — Create a new record for the selected 

table  

• Update — Update an existing record in the 

selected table, identified by the mandatory 

sys_id field. 

Get keys (Displayed only if the Get 

operation is selected) 

If this checkbox is checked, the Get operation 

returns all matching records and their fields. 

Extended Query Parameters (Displayed 

only if the Get operation is selected) 

Invokes the Extended Query Parameters page. 

Use this page to configure event criteria and 

extended query parameters used to filter the 

returned results. See Configuring ServiceNow 

Adapter Invoke Extended Query Parameters 

for a description. 

Test Get Operation (Displayed only if the 

Get operation is selected) 

Test Get Operation is enabled when the user 

selects the Get operation. Enables you to test 

the operation based on the parameters you 

selected. 

Configuring ServiceNow Adapter Extended Query 

Parameters 

Enter the ServiceNow Adapter extended query parameter values for your integration. 

Note: This page is invoked by clicking the Extended Query Parameters button on the 

Operations page. 

This section consists of the following topics: 

 What You Can Do from the ServiceNow Adapter Extended Query Parameters Page 

 What You See on the ServiceNow Adapter Extended Query Parameters Page 

What You Can Do from the ServiceNow Adapter Extended Query 

Parameters Page 

You can specify the following values on the ServiceNow Adapter Extended Query Parameters 

page. 

 Specify the extended query parameters. 

 Select the fields to include in the query. 
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What You See on the ServiceNow Adapter Extended Query 

Parameters Page 

The following table describes the key information on the ServiceNow Adapter Extended Query 

Parameters page. For example, if you selected Incident as the table in which to query records 

and GET as the operation to perform on the table in ServiceNow, you may select a number from 

the Order by dropdown list in the Extended Query Parameters section and select 

short_description in the Include Fields section. 

Element Description 

Extended Query Parameter Select the extended query parameters to use 

from the following list: 

• Order By — Uses the specified field to order 

the returned results. 

• Order By desc — Uses the specified field to 

order the returned results in descending order. 

• First row — Offsets the results by this 

number of records from the beginning of the 

set. When used with Last row, it has the effect 

of querying for a window of results. The 

results include the first row number. 

• Last row — Limits the results by this 

number of records from the beginning of the 

set or the start row values when specified. 

When used with First row, it has the effect of 

querying for a window of results. Returns 

fewer results than the last row number and 

does not include the last row. 

• Limit — Limits the number of records 

returned. 

• Use view — Specifies the name of a form 

view that is used to limit and expand the 

returned results. When the form view contains 

deeply referenced fields (for example, 

caller_id.email), this field is also 

returned in the result. 

Include Fields Select the fields to include. 

Filter By Field Name 

 
Type the initial letters of the field name to 

filter the display of names in the list. 

Available Displays the fields available to select from the 

module. 

Selected Displays the selected fields. 

Encoded query Build a custom query. For example: 

Incident number is INC0022759 

AND Active is true 

OR  

Incident number is INC0022756 

AND Active is false 
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Reviewing Configuration Values on the Summary Page 

You can review the specified adapter configuration values on the Summary page. 

This section consists of the following topics: 

 What You Can Do from the Summary Page 

 What You See on the Summary Page 

What You Can Do from the Summary Page 

You can review source or target configuration details from the Summary page. The Summary 

page is the final wizard page for each adapter after you have completed your configuration. 

 View the configuration details you defined for the source or target adapter. For example, if 

you have defined an inbound source adapter with a request business object and immediate 

response business object, specific details about this configuration are displayed on the 

Summary page. 

Note: In case of inbound source adapter, Next Steps will be displayed to guide the user about 

the post-deployment steps on the Summary Page. 

 Click Done if you want to save your configuration details. 

 Click a specific tab in the left panel or click Back to access a specific page to update your 

configuration definitions. 

 Click Cancel to cancel your configuration details. 

What You See on the Summary Page 

The following table describes the key information on the Summary page. 

Element Description 

Summary Displays a summary of the source or target 

configuration values you defined on previous 

pages of the wizard. To return to a previous 

page to update any values, click the appropriate 

tab in the left panel or click Back.  
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7  

Managing Applications 

This section describes how to manage and monitor an Oracle SOA Suite or Oracle Service Bus 

application that uses the adapter from Oracle Enterprise Manager Fusion Middleware Control or 

Oracle Service Bus Console. 

This chapter consists of the following sections: 

 Post Deployment Steps of Inbound Adapter 

 Managing the Application in Oracle Enterprise Manager Fusion Middleware Control 

 Testing Oracle Service Bus Projects from Oracle Service Bus Console 

Post Deployment Steps of Inbound Adapter 

After completing the development of the Integration flow, you need to carry out the following 

tasks: 

1. Activate the Integration flow. 

2. Log in to the ServiceNow instance with valid credentials. 

3. Search for 'Business Rules' in quick search and select 'Business Rules'. 

4. Search for the Business Rule starting with the name ORA_ and click it. 

5. Locate the script box and enter your WebLogic credentials between quotes. 

6. Click the update button on the same page. 

Managing the Application in Oracle Enterprise Manager 

Fusion Middleware Control 

You manage the SOA composite application or Oracle Service Bus business service that 

includes your adapter in Oracle Enterprise Manager Fusion Middleware Control. 

1. Log in to Oracle Enterprise Manager Fusion Middleware Control. 

2. In the navigator, expand the tree to display your SOA composite application or Oracle Service Bus 

business service project (for this example, a SOA composite application is selected). 

3. Select the SOA composite application. 

4. Click Test. 

The Test Web Service page is displayed. 

5. Complete the fields on the page to initiate a test of your composite. 

6. Click Test Web Service. 

Invocation results are displayed. 
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7. Click Launch Flow Trace to view the flow trace of the SOA composite application, including 

flow details about the adapter. 

For more information about monitoring applications from Oracle Enterprise Manager Fusion 

Middleware Control, see Administering Oracle SOA Suite and Oracle Business Process 
Management Suite and Administering Oracle Service Bus. 

Testing Oracle Service Bus Business Services from Oracle 

Service Bus Console 

You can test Oracle Service Bus business service projects from Oracle Service Bus Console. 

1. Log in to Oracle Service Bus Console. 

2. In the navigator under All Projects, open the project to test. 

3. In the navigator, click the business service for that project. 

4. Click the Launch Test Console (green arrow button) to test the outbound endpoint. 

This opens a window that displays the proxy service and the operation to test. 

5. Provide the input and click Execute. 

This sends the payload to the Oracle Cloud application. The response is displayed under the 

Response Document section. 

6. For more information about testing Oracle Service Bus business service projects, see 

Administering Oracle Service Bus. 


